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1 ASIDC ECOTEST SOFTWARE 

 

1.1 Foreword 

The Scientific and Production Private Enterprise “Sparing-Vist Center” is a well-

known developer and manufacturer of radiation measurement instruments and systems 

of ECOTEST trademark in Ukraine and worldwide. Today, there is a growing need for 

new and technically advanced radiation measurement instruments. In order to further 

develop and increase its competitiveness, the company has developed a new software 

for integrated individual dosimetric monitoring of personnel at nuclear power 

facilities, companies and institutions that deal with ionizing radiation sources. 

ASIDC Ecotest Software meets the latest technical and technological 

requirements for design and functionality. ASIDC Ecotest as part of the individual 

dosimetry control system is intended for work with DKG-21 and DKG-21M personal 

gamma radiation dosimeters as a hardware system component.  

 

1.2 Software and Hardware requirements 

1. The IBM-compatible personal computer (hereinafter - PC) running Windows 

10 is needed to operate ASIDC Terminal application. The PC must be equipped with 

USB/IrDA ECOTEST adapter or a similar model. 

2. A PC running *NIX or Windows family system with the installed Apache, 

Nginx, IIS or a similar server PHP v 5.3. supported or higher version is required for 

operation of the Web client (Control Panel). The hardware requirements must comply 

with those of Apache and Microsoft. 

3. A PC running *NIX or Windows family OS with the installed Java Runtime 

Environment, as well GlassFish 4.0 or Tomcat 7 web-server are required to ensure 

operation of the server. 

4. To use the system, you need a PC with the following minimum characteristics: 

Intel Core i5 or Intel Xeon processor and 4 GB RAM. 

5. For a comfortable use of the system, all computers must be connected to a 

local network with a data rate of at least 100 MB/s (100BASE-T). 

 

1.3 Purpose of use 

The software is intended for functioning as part of the "Stand-alone portable 

radiation monitoring kit for NPP emergency and radiation surveillance teams" as a 

subsystem of collecting, storage and processing of dosimetric information to keep an 

automated database of personnel radiation exposure, where personal gamma radiation 

dosimeters DKG-21 and DKG-21M are used. 
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ASIDC Ecotest SW is intended for: 

 Automated contactless reading of measurement results from the dosimeters and 

data storage in the database; 

 Automated contactless programming of operating modes of the dosimeters; 

 Storage, control, viewing in tabular and graphic form, further processing, 

generation and printing out reports on dosimetric measurements results. 

Information about proper operation and use of technical capabilities of personal 

gamma radiation dosimeters DKG-21 and DKG-21M can be found in the operating 

manual for a specific type of the dosimeter. 

 

1.4 Software configuration 

The software consists of three functionally interconnected subsystems: 

 Terminal (ASIDC Ecotest Terminal) 

 Web Client (Control Panel) 

 Hosting server. 

Terminal is responsible for operation with dosimeters and sends data to the 

server. It runs on the PC with the installed Windows OS. 

Web Client displays data, generates reports, and administers the system. 

Hosting server is responsible for receiving, storage, processing and providing 

data in accordance with the user’s access rights. 

 

1.5 User identification 

Users are identified in the system using login/password pair. Login is a unique 

identifier that enables unambiguous identification of each user. Password is a secret 

code known only to the user and used to confirm user’s identity.  
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2 WEB CLIENT (Control Panel)  

 

Web client is a software module, which allows managing users, dosimeters, 

programming templates, and other system objects, as well as browsing dosimetric 

information. Besides, Web client allows viewing reports about the collected data in a 

convenient form. 

 

2.1 Authorization 

1. Open a browser with an access to the server. Input an IP address or a domain 

name (ask your administrator, who installed the server software) in the address bar. 

2. Pass authorization by entering your login and password in the authorization 

form to start working with the system. 

3. Click [Log in] or press <Enter> key. 
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2.2 User interface 

 

 
 

1. Main menu. 

2. Home screen of the application (serves to display information according to the 

selected items in the menu) 

3. Interface language switch 

4. Log out button  

 

Personal page – information about the user and his\her accumulated dose. 

Besides, here you can view, printout or export personal reports about accumulated 

dose and sessions into .doc (for MS Word), .xls (for MS Excel) or .xml open formats.  

General reports – provides extended information about collected data in a 

tabular or graphical view, an option to print out or export data to .doc (for MS Word), 

.xls (for MS Excel) or .xml open formats. 

Users – provides information about all users and their access to personal data. 

Categories – information on the categories and maximum permissible exposure 

limits for each category.  

Dosimeters – information about the dosimeters registered in the system. 

Terminals – information about registered terminals, which can communicate 

data collected from the dosimeters to the server. 
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This menu and interface can change according to user’s access 

rights. 

Programming templates – information about the templates of operation modes 

settings for dosimeters programming, which were preset by the system administrator. 

Change password – you can change your login password here. 
 

 

 

2.3 Users 

Users’ page is available to administrators, operators and observers. They can 

view user’s personal data and accumulated doses. Only administrators may add new 

users or edit their personal data. 

 

 
 

1. Filter users. 

2. A switch to the form of new user adding to the system.  

3. A switch to a personal page of the selected user. 

4. A switch to user's data editing form. 

5. Delete a user. 

2.3.1 Filter users: 

1. By category – select the required checkbox in the categories that will be 

displayed in the list and click [Filter]; 

2. By access level – select the groups you want to filter and click [Filter]. 
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Login should consist of no less than 3 and no more than 32 
symbols. You may use Latin letters and digits. The first symbol of 

your login should be a letter. 

2.3.2 Add new user 

To add a new user you have to fill in the form (all fields have to be filled in) and 

click [Save]. The user will be added to the list. 

To add user’s photo click [Select photo] button, click [Open] as soon as you 

choose the file. 

 

 
 

 

After clicking [Save] button, a message about creation of a new user appears with 

his/her personal login password. Remember this password because it will be used to 

log into Web client or Terminal. The user can later change it by choosing Change 

Password in the menu. 
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If necessary, the administrator can reset the password of any user. To do this, go 

to the control panel/users/, click on the employee’s surname. Choose Reset password 

in the open menu. Remember new password. 

 

 
 

2.3.3 Edit user data 

When you open the user data edit form, you can change any data except login (it 

is non editable). To change the category or the access level, select what you need from 

the list. 

To delete a photo, select [Delete photo] checkbox, then [Select photo] to change 

it. 

After editing the data, click [Save] and the user's personal information will be 

changed. 
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2.3.4 Delete user 

To delete a user, click      in the user list, or [Delete user] button on his\her 

personal page, and then the following message will appear: 

 

 
 

If you really want to delete this user click [ОК]. 

2.3.5 View user's personal information 

To navigate to your personal page, you need to click on [Personal Page] button or 

select the desired user from the list. Other users’ personal information is available for 

viewing to administrators, operators and observers, but every employee can view only 

his/her own information and reports. 

 

 
 

1. A switch to data editing form. 

2. Reset password. 

3. Delete user. 

4. User’s main information. 

5. Accumulated doses for a certain period (day, month, quarter and year). 

6. Dose accumulation limits specified for the category to which the user belongs. 

7. A switch to user's personal reports.  
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2.3.6 Accumulated dose report 

Displays dose accumulation dynamics over specified time. This report is 

available to administrators and observers, but every employee can view only his/her 

own report. 

 

 
 

1. Export data to .doc, .xls or .xml format and print report. 

2. Filter data. 

3. Dose accumulation graphs. 

4. A switch to session report. 

5. Range exceeding: during accumulation of ambient dose equivalent, the 

dosimeter measurement range was exceeded. 

6. Power off: power of the dosimeter was incorrectly disabled during the session. 
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Data export 

 Click an icon to export data to: 

       .doc (for further work in word processor MS Word); 

       .xls (for MS Excel spreadsheet); 

       .xml, enables data processing in any application, which reads this format.  

To print the report click Print  icon. 

 

Report data filtering  

 Included - the period from/to, for which information should be displayed; 

 Excluded - the period from/to, which should be ignored/excluded when 

outputting information; 

 Serial number – input dosimeter’s number; 

 Model – choose the dosimeter’s model from the list. 

 

Graph 

The graph displays information filtered by the user. To select a specific period of 

accumulated dose, you need to highlight the desired segment in the graph below by 

clicking the left mouse button or moving the selection area to the sides. 

 

 
 

When rolling over the point in the graph, information about the value of 

accumulated dose and the date when data was obtained is displayed. 

  



User Guide 13 

ASIDC Ecotest Software 

for automated system of individual dosimetry control 

 

2.3.7 Personal sessions report 

Displays information about dosimeter sessions (time of receipt, time of handing 

in, accumulated dose, etc.) over some period for a specific user. 

This report is available to all users to view their personal data. Only 

administrators and observers can view other users’ information. 

 

 

 

1. Export data to .doc, .xls or .xml format and print report. 

2. Filter data. 

3. Dose accumulation graphs. 

4. Open session report. 

5. Range exceeding: during accumulation of ambient dose equivalent, the 

dosimeter measurement range was exceeded. 

6. Power off: power of the dosimeter was incorrectly disabled during the session. 
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2.3.8 Session report 

Click the session’s number in the report on accumulated dose or users’ sessions to 

switch to this page. 

 

 
 

1. Export data to .doc, .xls or .xml format and print report. 

2. Input number to switch to another session. 

3. Information about a session and dosimeter, which was used during it. 

4. Power off: power of the dosimeter was incorrectly disabled during the session. 
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The amount of information provided in the reports can differ from the 

given above depending on the user’s access rights. 

 

2.4 General reports 

This page contains information about general (not personal) data in tabular or 

graphic view. 

 

 
 

 

2.4.1 Session general report 

Only administrators of the system and observers can view this report. 

 

 
 

1. Export data to .doc, .xls or .xml format and print report. 

2. Filter data by session date (Included/Excluded).  

3. Open personal page of the selected user. 

4. Open certain session report. 

5. Range exceeding: during accumulation of ambient dose equivalent, the 

dosimeter measurement range was exceeded. 

6. Power off: power of the dosimeter was incorrectly disabled during the session. 
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2.4.2 Users report 

This report contains general information on the accumulated dose of all users 

over a given period of time with an option of comparing and analyzing data. The 

report allows you to filter users by exceeding certain limit of yearly, monthly, daily 

dose. This report is only viewable by administrators and observers. 

 

 
 

1. Export data to .doc, .xls or .xml format and print report. 

2. Graph. 

3. Filter users. 

4. Select a field to create graphics. 
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You can filter users by the following criteria: 

 Category 

 Access level 

 Dose: for a day, month, quarter, year, and for exceeding a certain dose threshold 

(more or less this dose) 

To choose certain users you have to select them with mouse pointer (users are 

numbered) on the graph. After hovering the cursor, the column displays information 

about the accumulated dose for a year, quarter, month, and day. 

2.4.3 Dosimeters report 

Contains information on the list of all dosimeters from which data was collected. 

This report is available to administrators, operators and observers of the system. 

 

 
 

1. Export data to .doc, .xls or .xml format and print report. 

2. Filer data. 

3. Dosimeters with an expired battery life and (or) expired calibration period are 

highlighted with red (the dosimeter needs calibration). 
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2.5 Categories 

This page contains a list of categories and maximum permissible values of 

accumulated dose that are defined for each of them. Access to this page is restricted to 

administrators and observers, but only administrators can add, remove, and edit 

categories. 

 

 
 

1. Add a new category (a window of new category creation appears). 

2. Edit the existing category. 

3. Delete category (after clicking, the "Are you sure?" message appears. If you 

really want to delete the category, click [OK].) 

2.5.1 Add new category 

To add a new category, you need to fill in the form (all fields must be filled in, 

except for the Comment field that is optional) and click [Save], after which the 

category will be registered in the system. 

 

 
 

  

Use not "comma", but "point" in all fields for the decimal point 

when you enter fractional numbers. 
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Serial number can be found on the dosimeter housing. 
The number consists of 7 digits. 

Select a dosimeter model from the drop down list. 

 

2.6 Dosimeters 

This page contains a list of all dosimeters registered in the system. It is available 

to administrators, operators, and observers, but only administrators can add, delete, 

and edit registered dosimeters. 

 

 
 

1. Filer dosimeters. 

2. Register new dosimeter (a new dosimeter registration window appears). 

3. Edit registered dosimeter. 

4. Remove dosimeter (after clicking, the "Are you sure?" message appears. If you 

really want to delete the dosimeter, click [OK]. 

To filter some dosimeter models, and, if necessary to replace the battery or carry 

out verification, check the box next to their name and click [Filter]. The dosimeters 

according to the set parameters will be displayed in the list. 

2.6.1 Register new dosimeter  

To register a new dosimeter, you need to fill in the form (all fields must be filled 

in) and click [Save], after which the dosimeter will be added to the list. 
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2.6.2 Edit registered dosimeter 

When you open the dosimeter edit form, you can change any data except serial 

number (it is unchangeable). To change the model, select the required one from the 

list. 

After editing the data, click [Save]. The dosimeter information will be changed. 

 

 
 

2.7 Terminals 

This page contains a list of all terminals that are registered in the system and can 

send data collected from the dosimeters to the hosting server. Administrators and 

observers have access to the page, but only administrators can add, remove, and edit 

terminals. 

 

 
 

1. Register terminal (a new terminal registration window appears). 

2. Edit registered terminal. 

3. Delete terminal (after clicking, the "Are you sure?" message appears. If you 

really want to delete the terminal, click [OK]) 
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Terminal’s serial number can be found in the Help menu of 
ASIDC Ecotest Terminal application. 

 

2.7.1 Register new terminal 

To register a new terminal, you need to fill in the form (all fields must be filled 

in, except for the Comment field that is optional) and click [Save], after which the 

terminal will be added to the system. 

 

 
 

 

2.8 Programming templates 

This page contains a list of predefined templates of dosimeter mode setting that 

the terminal will offer to the operator during the dosimeter programming. Access to 

this page is available to administrators, operators, and observers, but only 

administrators can add, delete, and edit programming templates. 

 

 
 

1. Add a programming template (a window of new template addition appears). 

2. Templates used for individual programming of dosimeters are highlighted with 

red. 

3. Edit the existing programming template. 

4. Delete (after clicking, the "Are you sure?" message appears. If you really want 

to delete the terminal, click [OK])  
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Check the box "Use template for individual mode" to create a 

programming template that will be used by employees when working 

with the terminal individually. Only one such template can be created. 

Password must contain not less than four and not more than sixteen 

characters. 

 

2.8.1 Add new programming template 

To add a new programming template, you need to fill in the form (all fields must 

be filled in), select the required dosimeter operating modes, and click [Save], after 

which the template will be added to the system. The counter of days (a box to the right 

of the "Dose storage interval") shows when the dosimeter’s memory will be filled 

during continuous operation with the given selected dose storage interval. 

 

 
 

 

2.8.2 Password change 

To change the password, you use to login, you must go to the "Change Password" 

page and fill in the appropriate fields, then click [Save]. The new password will be 

saved in the system. 
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3 ASIDC ECOTEST TERMINAL 

 

Terminal is a software module designed to work with DKG-21 dosimeters and 

other compatible models. The terminal allows the dosimeter to be programmed to 

work and read data accumulated during operation of the dosimeter. The readout data 

is divided into sessions. A session is a period of time from the moment the dosimeter 

is programmed to the moment of accumulated data reading. 

 

3.1 Authorization 

To open the terminal, click on  icon on the desktop. 

Enter login and password to start the program, then click [Enter] or <Enter> key. 

 

 
 

Input the IP address in the Server line (ask your administrator who installed the 

server software). If you want to change the IP address, click on it and enter the new 

one. 
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3.2 User interface 

Access to the full version of the application is only available to the operator. 

 

 

 

1. Main menu. 

2. Toolbar. 

3. Search for users. 

4. Filter users. 

5. Home screen of the application (the list of users). 
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3.2.1 Main menu 

File - by choosing this tab, you can log off. 

Dosimeter - here you can program the dosimeter or read data from it. 

Settings - allows you to select a COM port with an infrared adapter for 

communication with the dosimeter, change the interface language and set the number of 

users to be visible on the screen. 

Help - view the terminal’s serial number. 

 

Tollbar buttons 

  Program dosimeter 

  Cancel session 

 Personal information 

Read data 

 Exit 

 

Search for users 

Enter the last name or name of the required user and it will be displayed in the 

list. 

 

Filter Users  

You can filter users in the list by the following criteria: 

1. By dose - select the required dose limit from the list (per day, month, quarter or 

year) and specify a value of more/less. 

2. By exceeding the dose limit (with exceeding, without exceeding). 

3. By dosimeters – an option to filter users with a dosimeter (during an open 

session) without a dosimeter or all users. 

4. By access rights - check the box next to the access levels that should be 

displayed in the list. 

5. By categories - check the box near the categories to be displayed in the list. 

 

Users list 

Employees with an open session are highlighted in blue and the table shows the 

dosimeter number assigned to the session. 

Employees whose accumulated dose exceeds the permissible norm, defined by 

the category, are highlighted in red (it is not possible to program the dosimeter for 

these users). 



User Guide 26 

ASIDC Ecotest Software 

for automated system of individual dosimetry control 

 

 

If you right-click on the user's name, a menu appears where you can view 

personal information of the employee, program the dosimeter for him/her, open a new 

session, or close an earlier open session if the dosimeter is out of order or lost and it is 

impossible to read data from it. 

 

3.3 Dosimeter programming 

Dosimeter programming window opens if you: 

 Double-click a left mouse button on the user's surname in the list; 

 Right-click on the surname and select in the shortcut menu [Program dosimeter]; 

 Click on the surname, then select in "Device" menu - "Program dosimeter"; 

 Click on the surname and click on the toolbar icon 

 

  

 

1. Personal information of the employee. 

2. List of dosimeter programming templates (if necessary). 

3. Setting the operating modes of the dosimeter (fields and checkboxes). 

4. Status bar. 
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The operator can set the operating modes of the dosimeter himself or choose one 

of the already defined programming templates. 

To start programming, turn on the dosimeter and, while symbols are flashing on 

the liquid crystal display (in maximum 15 s), place it so that the infrared port window of 

the dosimeter is at a distance of no more than 0.3 m in front of the USB/IrDA adapter 

window, and press [Program] button. Successful programming of the dosimeter is 

accompanied by a sound short-term signal of the dosimeter. Programming process will 

be displayed in the status bar (PROGRAMMING  SENDING DATA  

COMPLETED: ХХХХХХХ (where digits are a serial number of the assigned 

dosimeter). 

 

 

 

After successfully programming of the dosimeter, click [Close] button. 
 

 

 

You can not program the dosimeter if: 

● The user has an already open session and a programmed dosimeter; 

● The user’s dose exceeds the permissible dose by the category; 

● The dosimeter’s life has expired; 

● The dosimeter is not registered on the server. 
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3.4 Read data from the dosimeter 

The data readout window opens in one of the following ways: 

 Choosing "Read data" in "Dosimeter" menu; 

 Clicking on the toolbar icon      . 

 

 

where: 1 – data reading status bar. 

To read data from the dosimeter, you need to press and hold the dosimeter’s 

MODE button before flashing of the liquid crystal display and, no more in 15 seconds, 

place it in the reading area so that the infrared port window of the dosimeter is not 

more than 0.3 m opposite the USB/IrDA adapter window. Data will be read 

automatically. The status bar will display the data readout process (READING  

SENDING DATA  COMPLETED). Ensure that the procedure of information 

reading from the dosimeter is successful due to blinking "DATA" indicator of USB 

data/IrDA adapter and a sound signal. As soon as data from the dosimeter is read, the 

window displays information about the employee, to whom the dosimeter was 

assigned. Close "Data Readout" window. 

 

 

  

When "READING" appears again in the status bar, you can put 

another dosimeter to the infrared port to read data. 
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3.5 Cancel session 

Operator can close an earlier open session if the dosimeter is out of order or lost 

and it is impossible to read data from it. 

To cancel a session, right-click on the employee's surname whose session you 

want to close and select [Cancel Session] from the shortcut menu, or left-click on the 

employee's surname whose session you want to close and click on the toolbar icon . 

Click [Yes] in the window if you really want to cancel the user session, or [No] if 

cancellation of the session is to be canceled. 

 

 
 

3.6 Personal information 

Personal Information window contains detailed information about the employee 

and exposure doses received by the employee for a specified period. 
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To open personal information you need to: right-click on the employee's surname 

and select [Personal Information] from the shortcut menu, or left-click on the 

employee's surname and click on               toolbar icon. 

To display the dose for a period (year, month, quarter, or day), select the required 

one in the Period list. To specify a different period, select the date from/to. 

The accumulated dose for the selected period will be displayed in the "Dose" field. 

You can scale the accumulated dose graph by selecting the desired time period by 

the cursor. 

 

3.7 Exit application 

To exit the application, do one of the following: 

• Click              in the upper right corner of the terminal app window; 

• Click on the toolbar icon ; 

• Choose "Exit" from the "File" menu. 

 

 

 

To exit the program, click [Yes] or [No] to return. 

 

3.8 Individual dosimeter programming 

All users (except operators) after logging in the terminal application will only 

access the programming and data reading window from the individual dosimeter. 

3.8.1 Dosimeter programming 

Once logged in, the "Dosimeter programming" window opens immediately. 

To start programming, turn on the dosimeter and while symbols on the liquid 

crystal display are flashing (in maximum 15 s), place it so that the infrared port 

window of the dosimeter is at a distance of no more than 0.3 m in front of the 

USB/IrDA adapter window, and press [Program] button. Successful programming of 

the dosimeter is accompanied by a sound short-term signal of the dosimeter. 

Programming process will be displayed in the status bar (PROGRAMMING  

SENDING DATA  COMPLETED: ХХХХХХХ (where digits are the serial number 

of the assigned dosimeter). 
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After successfully programming of the dosimeter, click [Close] button. 

3.8.2 Read data from the dosimeter 

To read data from the dosimeter, the employee must log in, after which the "Data 

Readout" window will open immediately. 

 

 

 

where: 1 – data reading status bar. 

To read data from the dosimeter, you need to press and hold the dosimeter’s 

MODE button before flashing of the liquid crystal display and, no more in 15 seconds, 

place it in the reading area so that the infrared port window of the dosimeter is not 

more than 0.3 m opposite the USB/IrDA adapter window. Data will be read 

automatically after that. The status bar will display the data read process (READING 

 SENDING DATA  COMPLETED). Successful procedure of information reading 

is accompanied by a sound signal of the dosimeter and flashing of the "DATA" 
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indicator of USB/IrDA adapter. As soon as data from the dosimeter is read, the 

window displays information about the employee, to whom the dosimeter was 

assigned.  

Close Data Readout window by clicking the [Close] button.  

3.8.3 Exit application 

To exit the application, do one of the following: 

• Click             in the upper right corner of the terminal app window; 

• Click on the toolbar icon  ; 

• Choose "Exit" from the "File" menu. 

 





To exit the program, press [Yes] or [No] to return. 

 


